
 

EntroGen, Inc Version 2.5 Page 1 of 31  

 

 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

 For In Vitro Diagnostic Use 
  

Store at -25oC to -15oC 
 

 

CTEGFR-48 

  

ctDNA EGFR Mutation Detection Kit 
For Real-Time PCR 
 
Kit for the detection of EGFR somatic mutations in circulating DNA in human plasma 

 
 
For Use With: 

• Bio-Rad® CFX96 

• QuantStudioTM 5 

• Qiagen Rotor-Gene Q 5plex 
 
 

 
 

 
 
 

 
Instructions for use - version 2.6 



ctDNA EGFR Mutation Detection Kit               Instructions for use For In Vitro Diagnostic Use 

 

EntroGen, Inc Version 2.6 Page 2 of 31  

 

Table of Contents 

1. Intended Use ........................................................................................................................... 3 
2. Reagents and Instruments ............................................................................................................ 4 

2.1 Package Contents ................................................................................................................. 4 
2.2 Handling and Storage ............................................................................................................. 4 
2.3 Product Stability .................................................................................................................. 4 
2.4 Quality Control .................................................................................................................... 4 
2.5 Warnings and Precautions ....................................................................................................... 5 

3. Required equipment & materials ................................................................................................... 6 
3.1 Reagents ........................................................................................................................... 6 
3.2 Equipment ......................................................................................................................... 6 

4. Product Description ................................................................................................................... 7 
4.1 Introduction ....................................................................................................................... 7 
4.2 About this assay ................................................................................................................... 7 
4.3 Limitations of the Assay ......................................................................................................... 7 

5. Instructions for Use ................................................................................................................... 9 
5.1 DNA isolation ...................................................................................................................... 9 
5.2 Reagent preparation (for all instruments) .................................................................................... 9 
5.3 Instrument Setup ................................................................................................................ 11 

6. Data Analysis ......................................................................................................................... 14 
6.1 Instrument Specific Analysis Steps ........................................................................................... 14 
6.2 Results Interpretation .......................................................................................................... 15 

7. Performance Validation ............................................................................................................ 16 
7.1 Precision ......................................................................................................................... 16 
7.2 Limit of Detection .............................................................................................................. 18 
7.3 Accuracy ......................................................................................................................... 20 
7.4 Cross-Reactivity ................................................................................................................. 21 
7.5 Limit of Blank ................................................................................................................... 22 

8. Appendix.............................................................................................................................. 23 
9. References ........................................................................................................................... 28 
10. Revision History .................................................................................................................... 29 
11. Symbols Used ....................................................................................................................... 30 
12. Contact Information ............................................................................................................... 31 
 

 



ctDNA EGFR Mutation Detection Kit               Instructions for use For In Vitro Diagnostic Use 

 

EntroGen, Inc Version 2.6 Page 3 of 31  

 

1. Intended Use 

The ctDNA EGFR Mutation Analysis Kit is intended for the detection of EGFR exon 18, 19, 20, & 21 somatic mutations in 

cell-free, plasma derived, human genomic DNA (cf-DNA).  

 

Warnings: The purchaser of this kit should follow the instructions in this manual.  Any off-label use of this kit, and/or 

modification of the components will void EntroGen’s support. 
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2. Reagents and Instruments 

2.1 Package Contents 

This product contains the following materials sufficient for 48 reactions.  When testing at a capacity of 10 samples per 

plate (that is, a full plate, as illustrated in section 5.2), the provided reagents are sufficient for 40 samples, one 

positive control, and one no-template control, across all 7 reactions: 

 

Name No. of Tubes Vol. per Tube (l) Cap 

CT Mutation Detection Reaction Mix 1 (2X) 
For Reaction 1 

1 800 
 

CT Mutation Detection Reaction Mix 2 (2X) 
For Reactions 2-7 

4 1300 
 

Primer/Probe Mix 7* 158 
 

Positive Control Mix (PC)§ 1 615 
 

* Each tube contains a distinct primer mix to amplify its designated mutations. The contents of these tubes should not be mixed. 
§ The positive control mix contains a mixture of synthetic DNA sequences that correspond to each mutation detected by this kit and an internal 

control. 

2.2 Handling and Storage 

This product is shipped on frozen ice packs.  The contents of the shipment should be stored at -25oC to -15oC non-frost-

free freezer immediately upon receipt.   

 

• Store all unopened components in original containers.   

• Primer/probe mixes should be protected from light at all times to prevent photo bleaching of the fluorescent 

dyes.  

• Centrifuge the tubes before opening.   

• The expiration date of each component is printed on each tube label. This product will maintain its 

performance through this date.  Its performance is not guaranteed after the expiration date. 

 

A brief summary of the required storage and handling conditions necessary to ensure optimal stability for the kit: 

 

CT Mutation Detection Reaction Mix 1 and 2 (2X): Store frozen between -25oC to -15oC.  Thaw reaction mixes one vial 
at a time and store between 2oC to 8oC for up to 30 days.  Do not freeze-thaw this reagent more than 3 times, as 
repeated freeze-thaw will adversely affect the efficiency of the enzyme.  If a single vial of this reagent is expected to 
be used longer than 30 days, small volume aliquots are recommended after the first thaw. 
 

Primer/Probe Mix: Store frozen between -25oC to -15oC. Once thawed, primer/probe mix will remain stable for up to 

30 days when stored between 2oC to 8oC.  If primer/probe mix is expected to be used longer than 30 days, small 

volume aliquots are recommended after first thaw for long term storage between -25oC to -15oC. 

 

Positive Control Mix: Store between 2oC to 8oC once thawed.   

2.3 Product Stability 

This product and its components will maintain performance through the expiration date printed on the labels of each 

tube given that the storage and handling conditions described above are properly followed. 

2.4 Quality Control 

The components of this product are manufactured under GMP (Good Manufacturing Practice) standard. GMP requires 

extensive validation and documentation of manufacturing procedures to ensure highest production quality.   
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Each batch is tested on a Bio-Rad CFX96 or QuantStudioTM 5 instrument. Certificate of Analysis for each batch is 

available at www.entrogen.com/pi-download/. 

2.5 Warnings and Precautions 

PCR amplification is extremely sensitive to cross-over contamination. It is very important to carry out the pre-

amplification steps (i.e. DNA isolation, PCR reaction preparation) in separate areas, ideally separate rooms with 

isolated air venting systems.  It is especially important that the PCR reaction preparation is carried out in a room with 

positive air pressure (or laminar flow hood).   

Additional precautions are necessary when handling DNA and PCR reagents to avoid contamination between 

samples/reagents: 

• Wipe down the work area, pipettes, and equipment to be used near the work area with surface decontaminant 

(20% bleach or equivalent) to eliminate DNA and DNase followed by 70% ethanol. 

• Vortex each tube before use. 

• Spin down all tubes in picofuge before opening. 

• Open each microcentrifuge tube carefully after vortexing/mixing and avoid touching the inside of the lid. 

• Use aerosol-resistant (filtered) tips for all pipetting steps to avoid cross-contamination. 

• Change pipette tips between all liquid transfers. 

• Always wear gloves when handling DNA/reagents and change gloves between the pre-amplification and post-

amplification steps. 

• The flow of tubes, racks, pipettes and other equipment used should be from pre-amplification to post-

amplification, and never backwards. 
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3. Required equipment & materials 

3.1 Reagents 

This kit does not contain reagents for protein digestion (Proteinase K) or the extraction of cell-free DNA.  Cell-free DNA 

can be extracted using EntroGen’s Cell-Free DNA Isolation Kit (Cat. No. CFDNA-50). See section 5.1 for more 

information regarding cfDNA isolation.   

 

This assay requires the use of nuclease-free water (PCR grade). 

3.2 Equipment 

Equipment required to perform this assay are: 

 

• Real-Time PCR instrument 

o Validated on:  

▪ QuantStudioTM 5 

▪ Bio-Rad CFX96   

o Compatible instruments require additional validation by user 

• Disposable powder-free gloves 

• Adjustable pipettes 

• Sterile filtered pipette tips 

• Vortex mixer 

• Picofuge for 0.2 ml and 2.0 ml microcentrifuge tubes 

• 96-well PCR plates  

• Optical sealing film for PCR plates 

• Centrifuge for PCR plates 

• 0.2 ml (optional) and 2.0 ml microcentrifuge tubes 

• Qubit reagents and instrument (or equivalent) 

• 70% ethanol 

• 20% chlorine bleach (or equivalent) 
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4. Product Description 

4.1 Introduction 

Epidermal growth factor receptor (EGFR) is a membrane protein that plays a central role in transmitting signals that 

promote cell growth and proliferation.  EGFR tyrosine kinase (TK) domain activates several downstream effectors that 

lead to activation of the Ras-Raf-MAPK pathway [1]. Overexpression and oncogenic mutations that constitutively 

activate the TK domain of EGFR have been found in various solid tumors.  Additionally, excessive activation of EGFR 

has been shown to be associated with advanced stages of cancer and a poor prognosis [2]. 

 

In a significant number of cases, tumor tissue is not available in sufficient amount for accurate molecular testing. 

Recent studies have demonstrated the utility of circulating tumor DNA (ctDNA) from plasma as an alternative source of 

genomic material for detection of sensitizing and resistance mutations in lung cancer [3]. 

 

4.2 About this assay 

The ctDNA EGFR Mutation Analysis Kit is an ultra-sensitive assay to detect somatic mutations in exons 18, 19, 20, and 

21 of EGFR in seven reactions. The assay works by amplifying mutant-specific sequences in samples that contain a 

mixture of mutant and wild-type DNA and relies on fluorescent probes for detection. The mutations detected by this 

kit are listed in Table A in the Appendix.  A summary of mutations detected in each reaction is shown in the table 

below. 

 

RXN Mutation Reporter 

1 

Exon 19 Deletions CY5 

T790M FAM 

L858R ROX 

2 C797S FAM 

3 L861Q FAM 

4 S768I FAM 

5 G719X FAM 

6 Ex20InsGGT/CAC FAM 

7 Ex20Ins9 (c.2300_2308dup) FAM 

All Internal control VIC 

 

Additional information about the mutations detected: 

• T790M with and without the presence of the neighboring SNP, (rs1050171 (c. G2361A, p. Q787Q), SNP 

Prevalence: 0.43 [4]) 

• G719X - detects G719A, G719S, G719D and G719C but does not distinguish between them 

• Exon 20 Insertions - detects insCAC and insGGT but does not distinguish between them 

• C797S – detects c.2389T>A and c.2390G>C, but does not distinguish between them 

 

This kit contains primer mixtures for the detection of the aforementioned EGFR mutations, as well as an internal 

control gene. The internal control primers amplify beta-2 microglobulin (B2M) and are used to determine the condition 

of reagents and whether the reaction contains sufficient amount of amplifiable DNA. 

 

4.3 Limitations of the Assay 

• Successful detection of target mutations is dependent on sample quality and the amount of amplifiable DNA 

available.  Samples that are overloaded or underloaded must be repeated.   

• The performance of this assay has not been established in the presence of rare polymorphisms. 

• This assay is intended for use with cell-free DNA only.  It is unknown if other sample types are suitable for 

testing with this assay. 
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• Whole blood must be immediately processed for cell-free DNA isolation.  Storage of blood prior to isolation will 

result in the formation of clots that will significantly reduce cell-free DNA yield.   

• Reagent carry-over from isolation may interfere with amplification efficiency.   

• This assay is intended to be used by laboratory personnel trained in molecular biology techniques. 

• Adherence to this protocol is required for optimal results.  Deviations from protocol may result in a loss of 

performance. 

• Combination of reagents from different kit lots has not been evaluated. The performance characteristics of this 

modification have not been established.  
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5. Instructions for Use 

5.1 DNA isolation 

Several methods exist for DNA isolation.  For consistency, we recommend using EntroGen’s Cell-Free DNA Isolation Kit 

(Cat. No. CFDNA-50).  

 

Follow the cf-DNA isolation procedure according to the protocol. This assay requires approximately 1.5-15 ng cf-

DNA/reaction. 

 

Streck Cell-Free DNA BCT Tube(s): Plasma from blood collected with Streck Cell-Free DNA BCT Tube(s) must go through 

a Proteinase K treatment prior to Cell-Free DNA isolation to ensure optimal yields. Forgoing Proteinase K treatment 

may decrease yields by 50%. 

 

After DNA isolation, measure the concentration using fluorometric (e.g., Qubit) or qPCR analysis and dilute it to 

between 0.5 and 3 ng/µl if necessary.  If the concentration is below 0.5 ng/µl, adjust the water volume during reaction 

setup.  DNA extraction from plasma gives low yields. Typical yields are expected to be within 0.2 - 3 ng/µl. Greater 

yields may be obtained when extracting from higher volumes of plasma (>5 ml), but high concentrations can also be 

indicative of gDNA contamination.   

 

Note: This DNA concentration is based on fluorometric analysis of isolated cf-DNA with Qubit Fluorometer. Some cf-

DNA isolation kits use carrier RNA to enhance the binding of nucleic acids to the silica membrane. Carrier RNA may 

contribute to the UV absorbance readings on spectrophotometers such as Nanodrop. Therefore, each lab should 

evaluate optimal DNA concentration for the assay. For more information, refer to the isolation kit product manual. 

 

5.2 Reagent preparation (for all instruments) 

• Thaw the primer/probe mix tubes, positive control mixes, and 2X mutation detection reaction mixes, on ice.  

o Each primer/probe mix tube in the kit contains enough reagents to perform the test on 48 samples 

(including controls).  

• Vortex and spin the tubes for about 5 seconds in picofuge at room temperature. 

 

Note: It is recommended to keep reagents, controls, and samples on ice. 

 

The PCR reactions are setup in a total volume of 30 µl/sample. Reaction mixes for multiple samples (as well as control 

samples) should be pre-mixed as a master mix with 5% excess volume to compensate for pipetting errors. 5 µl of the 

positive control should be tested with each reaction on every plate. 

 

The following reagents go into each 30 µl reaction: 

 

Components Volume (l) 

CT Mutation Detection Reaction Mix 1 (2X) OR 

CT Mutation Detection Reaction Mix 2 (2X) 
15 

Primer Mix 3 

cf-DNA sample (1.5-15 ng) 5* 

Nuclease-free water 7** 

*Sample volume may range between 1 µl and 12 µl.  

**Water volume should be adjusted according to the sample volume to complete a 30 µl reaction. 
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1. Prepare the following master mixes using the formulas below to calculate the appropriate volumes (with 5% 

overage). Prepare a separate master mix for the positive controls and NTC if your sample volume is not 5 µl.  

The water volume should be 7 µl for the positive control and NTC master mix, but should be adjusted to 

complete a 30 µl reaction if your sample volume is not 5 µl. 

 

For Reaction 1: 

Reagents Formula* 

CT Mutation Detection Reaction Mix 1 (2X) N x 15 µl x 1.05 

Reaction 1 Primer Mix N x 3 µl x 1.05 

Nuclease-free water N x 7 µl* x 1.05 

 N = number of samples to be run (including controls). 

 * Water volume in this formula is calculated based on a 5 µl sample input per reaction.    

 

For Reactions 2-7: 

Reagents Formula* 

CT Mutation Detection Reaction Mix 2 (2X) N x 15 µl x 1.05 

Reactions 2-7 Primer Mixes N x 3 µl x 1.05 

Nuclease-free water N x 7 µl* x 1.05 

 N = number of samples to be run (including controls). 

*Water volume in this formula is calculated based on a 5 µl sample input per reaction.    

 

2. Mix by gentle vortexing and centrifuge for 5 seconds in picofuge at room temperature. 

3. Dispense 25 µl of the master mix per well.  Adjust the master mix volume if sample volume is not 5 µl. 

4. Dispense 25 µl of positive control and NTC master mix per control well. 

5. Add 1-12 µl of cf-DNA sample to each corresponding well and mix by pipetting up and down several times  

6. Add 5 µl of the positive control and water (NTC) to the corresponding control wells and mix by pipetting up and 

down several times. 

7. Seal the plate with optical sealing film (for plates) or caps (for tubes). 

8. Briefly centrifuge the plate to collect reaction at the bottom of the wells and to ensure that there are no 

bubbles in the bottom of the wells. 

 

 
Note: Seven reactions are setup for each sample.  A single 96-well PCR plate can accommodate up to 10 unknown samples, one 

positive control mix, and one no template control mix.  The recommended plate layout is shown above.
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5.3 Instrument Setup 

Bio-Rad CFX96 (CFX Manager Software version 3.1 and above) 

1. In the Startup Wizard select Create New Experiment and make sure CFX96 is selected in the drop-down list.  

Click OK. 

2. In the Protocol tab of the Experiment Setup window select Create New and enter the following cycling 

parameters: 

 

Step Temperature Time 

1 95oC 10min 

2 95oC 15sec 

3 58oC 30sec 

 + Plate Read 

4 GOTO 2 39 more times 

 END  

 

3. When finished, click OK to save the protocol template.  Note the location of the saved template file to use for 

subsequent runs.  Click Next to go to the setup window. 

4. Change the Sample Volume to 30 µl. 

5. Set the Fluorophores to All Channels. 

6. Click Next, then click Start Run to begin the run. 

 

ABI QuantStudioTM 5 (Software version 2.0 and above) 

1. In the QuantStudio Design and Analysis software, select create new experiment. 

2. In the Properties tab: 

a. Select “96-Well 0.2 mL block” under Block 

b. Select “Comparative Ct (ΔΔCt)” under Experiment type 

c. Select “TaqMan® Reagents” under Chemistry  

d. Select “Fast” under Run mode  

3. In the Method tab:  

a. Change the volume to 30 µl  

b. Change the cooling ramp rate to 2.38oC/sec and all other ramp rates to 3oC/sec as shown below 

c. Enter the following cycling parameters: 

 

Step Temperature Time 

Hold stage 

 Ramp rate 3oC/sec 

1 95oC 10min 

PCR stage 

 Ramp rate 3oC/sec 

1 95oC 15sec 

 Ramp rate 2.38oC/sec 

2 58oC 30sec 

 + Plate Read 

Cycle PCR stage 40x 

END 
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4. In the Plate tab: 

a. Set passive reference to “None”. 

b. Click the Advanced Setup tab and add the following targets under the Targets field. 

 

Target Name Reporter Quencher 

RXN 1 Ex19Del CY5 NFQ-MGB 

RXN 1 T790M FAM NFQ-MGB 

RXN 1 L858R ROX NFQ-MGB 

RXN 1 IC VIC NFQ-MGB 

RXN 2 C797S FAM NFQ-MGB 

RXN 2 IC VIC NFQ-MGB 

RXN 3 L861Q FAM NFQ-MGB 

RXN 3 IC VIC NFQ-MGB 

RXN 4 S768I FAM NFQ-MGB 

RXN 4 IC VIC NFQ-MGB 

RXN 5 G719X FAM NFQ-MGB 

RXN 5 IC VIC NFQ-MGB 

RXN 6 Ex20InsGGT/CAC FAM NFQ-MGB 

RXN 6 IC VIC NFQ-MGB 

RXN 7 Ex20Ins9 FAM NFQ-MGB 

RXN 7 IC VIC NFQ-MGB 

  

5. Under the Samples field, assign sample IDs to the desired wells.  

6. Click Save to save the run file. 

7. Open the run file on the QuantStudioTM 5 instrument. 

8. Make sure the reaction volume is set to 30 µl and Data Collection is turned on at the 58°C step. 

9. Load the plate onto the instrument and click START RUN. 

 

Rotor-Gene Q (5plex) (Software version 2.1.0 and above) 

 

1. Select File>New, click on the Advanced tab in the dialog box, select Two Step and click New. 

2. Select 72-well rotor, check the “Locking Ring Attached” box, click Next, then skip wizard. 

3. Go to View>Run Settings, enter 30 µl for Reaction volume and click OK. 

4. Go to View>Profile Editor.  

5. Click on Hold and enter 95oC for Hold Temperature and 10 minutes for Hold Time. 

6. Click on Cycling, enter “This cycle repeats” 40 time(s), then enter the following Timed Step parameters by 

clicking on each step in the panel on the right: 

Step Temperature (°C) Time Data Acquisition 

Hold 95oC 10 min Not Acquiring 

Timed Step 95oC 15 Sec Not Acquiring 

Timed Step 58oC 30 Sec 
Acquiring to Cycling A on 
Green, Yellow, Red, Orange 

 

7. Click OK.  

 

Optional:  Save these run settings for future use by selecting the Save As button at the top of the dialog box. 
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8. Go to Gain, enter the following settings: 

 

Note: The suggested gain settings may need to be adjusted due to instrument-to-instrument variability.  

Detector Gain 

Green 6.67 

Yellow 10 

Orange 5 

Red 5 

 

9. Load the strip tubes into the rotor. 

10. Go to Run>Start Run, then click on the Start button to begin the run. 

 

Note: The Edit Samples dialog box opens once the run begins. Input sample information while the instrument is 

running or after the run has completed.  
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6. Data Analysis 

Important: Threshold settings may require adjustment based on the fluorescence detection sensitivity of each 

thermocycler.  Use the settings listed below as a starting point.   

 

6.1 Instrument Specific Analysis Steps 

 

Bio-Rad CFX96 (CFX Manager Software version 3.1 and above) 

Analyze the data in the real-time PCR instrument software using the following criteria: 

• Ct Determination Mode: Single Threshold 

• Baseline Setting: Baseline Subtracted Curve Fit 

• Baseline and Threshold: User Defined according to the table below: 

 

Target RXN Baseline Threshold 

HEX (VIC) 

1, 2 3-22 700 

3, 4, 6, 7 3-22 450 

5 3-22 400 

FAM 
1 3-22 400 

2-7 3-22 300 

ROX 1 3-22 400 

CY5 1 3-22 300 

 

ABI QuantStudioTM 5 (Software version 2.0 and above) 

Analyze the data in the real-time PCR instrument software using the following criteria: 

• Baseline and Threshold: User Defined according to the table below: 

 

Target RXN Baseline Threshold 

HEX (VIC) 

1, 2 3-22 55,000 

3, 4, 6, 7 3-22 27,500 

5 3-22 20,000 

FAM 
1 3-22 65,000 

2-7 3-22 40,000 

ROX 1 3-22 35,000 

CY5 1 3-22 30,000 

 

Rotor-Gene Q (5plex) (Software version 2.1.0 and above) 

Analyze the data in the real-time PCR instrument software using the following criteria: 

• Dynamic Tube: On 

• Slope Correct: On 

• Outlier removal: 5% 

 

Set the Thresholds as follows: 

 

VIC -Yellow FAM - Green CY5 - Red ROX – Orange 

0.1 0.15 0.05 0.05 
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6.2 Results Interpretation 

 

Bio-Rad CFX96 (CFX Manager Software version 3.1 and above) 

1. Select the positive control wells and check detector for a signal. PC should have similar VIC Ct values for each 

reaction. 

2. Select the negative control wells and confirm there is either no signal or the Ct value is greater than 38.5 for 

each detector. 

3. Select the reaction wells of each unknown sample and check the signal for each detector. Use the Ct table 

below to interpret results.   

 

Target Ct is: VIC (HEX) Ct is: Result 

Ct = any  Ct <28   Overloaded. Rerun with less DNA. 

38.5< Ct; Ct=N/A 28≤ Ct ≤ 31.5   Negative sample. No need to rerun. 

Ct ≤38.5 28≤ Ct ≤ 31.5   
Positive for target channel: Ex19Del (Cy5), 

L858R (ROX), all others (FAM). 

Ct = any Ct >31.5; Ct=N/A Underloaded. Rerun with more DNA. 

 

ABI QuantStudioTM 5 (Software version 2.0 and above) 

1. Select the positive control wells and check detector for a signal. PC should have similar VIC Ct values for each 

reaction.  

2. Select the negative control wells and confirm there is either no signal or the Ct value is greater than 38.5 for 

each detector. 

3. Select the reaction wells of each unknown sample and check the signal for each detector. Use the Ct table 

below to interpret results.   

 

Target Ct is: VIC (HEX) Ct is: Result 

Ct = any  Ct <28   Overloaded. Rerun with less DNA. 

38.5< Ct; Ct=Undetermined 28≤ Ct ≤ 31.5   Negative sample. No need to rerun. 

Ct ≤38.5 28≤ Ct ≤ 31.5   
Positive for target channel: Ex19Del (Cy5), 

L858R (ROX), all others (FAM). 

Ct = any Ct >31.5; Ct= Undetermined Underloaded. Rerun with more DNA. 

 

Rotor-Gene Q (5plex) (Software version 2.1.0 and above) 

1. Select the positive control wells and check detector for a signal. PC should have similar VIC Ct values for each 

reaction.  

2. Select the negative control wells and confirm there is either no signal or the Ct value is greater than 38.5 for 

each detector. 

3. Select the reaction wells of each unknown sample and check the signal for each detector. Use the Ct table 

below to interpret results.   

 

Target Ct is: VIC (Yellow) Ct is: Result 

Ct = any  Ct <23.5 Overloaded. Rerun with less DNA. 

38.5< Ct; Ct=0 23.5 ≤ Ct ≤ 27   Negative sample. No need to rerun. 

Ct ≤38.5 23.5 ≤ Ct ≤ 27   
Positive for target channel: Ex19Del (Cy5-Red), 

L858R (ROX-Orange), all others (FAM-Green). 

Ct = any Ct >27; Ct=0 Underloaded. Rerun with more DNA. 
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7. Performance Validation 

7.1 Precision  

The assay’s reproducibility was determined by analyzing synthetic DNA representing the target mutations, at an allelic 

frequency of 2X LoD in the background of wildtype DNA at the minimum input of the assay (at least 20 replicates per 

target mutation). Samples were tested across three reagent lots, by two different operators, on non-consecutive days. 

This study was performed on Bio-Rad CFX96 and ABI QuantStudioTM 5.  

 

Bio-Rad CFX96 (CFX Manager Software version 3.1): 

Reaction Mutation 
Mutant 
Copies 

No. of 
Repeats 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 

RXN 1 

T790M (with Q787Q SNP) 25 27 31.22 0.51 35.69 0.69 

T790M 50 22 31.28 0.41 34.10 0.35 

Exon 19del 25 20 30.99 0.17 34.41 0.36 

L858R 50 28 31.29 0.38 35.15 0.50 

RXN 2 
C797S T>A 50 30 31.25 0.24 35.19 0.59 

C797S G>C 50 22 31.11 0.22 34.20 0.54 

RXN 3 L861Q 25 22 31.00 0.28 35.08 0.32 

RXN 4 S768I 100 20 31.55 0.50 34.93 0.65 

RXN 5 

G719A 50 23 30.84 0.30 34.24 0.35 

G719C 50 28 30.91 0.28 35.07 0.65 

G719D 100 23 30.89 0.30 34.09 0.33 

G719S 100 24 30.98 0.34 34.03 0.31 

RXN 6 
Exon 20 ins GGT 50 24 31.36 0.44 34.19 0.36 

Exon 20 ins CAC 25 26 31.39 0.51 35.52 0.54 

RXN 7 Exon 20 ins 9 50 20 31.27 0.41 36.10 0.77 
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ABI QuantStudioTM 5 (Software version 2.0): 

Reaction Mutation 
Mutant 
Copies 

No. of 
Repeats 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 

RXN 1 

T790M (with Q787Q SNP) 25 20 30.91 0.18 34.92 0.60 

T790M 50 20 30.95 0.16 33.39 0.38 

Exon 19del 25 20 30.98 0.19 33.56 0.51 

L858R 50 20 31.18 0.40 33.59 0.59 

RXN 2 
C797S T>A 50 20 31.26 0.23 33.73 0.66 

C797S G>C 50 20 31.19 0.17 33.30 0.52 

RXN 3 L861Q 25 20 31.24 0.31 35.06 0.67 

RXN 4 S768I 150 22 31.47 0.26 35.01 0.44 

RXN 5 

G719A 50 22 31.12 0.24 33.51 0.43 

G719C 100 22 31.12 0.27 33.74 0.51 

G719D 100 22 31.16 0.27 34.83 0.85 

G719S 100 22 31.38 0.32 34.65 0.37 

RXN 6 
Exon 20 ins GGT 50 20 31.55 0.28 33.66 0.47 

Exon 20 ins CAC 50 20 31.49 0.24 33.63 0.51 

RXN 7 Exon 20 ins 9 50 20 31.67 0.33 35.45 0.63 
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7.2 Limit of Detection 

Limit of detection was assessed using synthetic mutant controls at a low copy number in the background of either WT 

cfDNA or fragmented DNA (to resemble the fragmentation pattern of cfDNA), at the assay’s minimum and maximum 

inputs (corresponding to a VIC Ct of 31.5 and 28, respectively). At least 4 sample preparations were tested across three 

reagent lots. At least 21 replicates were tested per target mutation at each DNA input. This study was performed on 

Bio-Rad CFX96 and ABI QuantStudioTM 5. 

 

Bio-Rad CFX96 (CFX Manager Software version 3.1): 

Reaction Mutation 

Minimum input (31.5 IC Ct) Maximum input (28 IC Ct) 

Mutant 
Copies 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 
Mutant 
Copies 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 

RXN 1 

T790M (with 
Q787Q SNP) 

10 31.82 0.27 36.88 0.72 25 28.04 0.26 36.42 0.91 

T790M 25 31.56 0.19 35.08 0.47 25 28.10 0.24 36.05 0.86 

Exon 19 del 10* 31.45 0.17 36.76 0.99 25* 28.10 0.20 35.66 1.04 

L858R 25 31.23 0.21 36.32 0.44 25 28.05 0.29 37.31 0.65 

RXN 2 
C797S T>A 25 31.73 0.18 36.82 0.56 50 28.39 0.17 37.46 0.52 

C797S G>C 25 31.85 0.27 36.20 0.67 25 28.28 0.29 37.08 0.68 

RXN 3 L861Q 10 31.40 0.18 36.60 0.75 10 27.90 0.25 36.78 0.48 

RXN 4 S768I 50 31.59 0.15 37.12 0.47 50 27.97 0.26 36.82 0.37 

RXN 5 

G719A 25 31.50 0.31 35.24 0.65 50 27.87 0.24 36.08 1.21 

G719C 25 31.51 0.26 36.39 0.52 100 27.90 0.21 36.18 1.14 

G719D 50 31.58 0.29 35.89 0.44 200 27.92 0.19 35.06 0.84 

G719S 50 31.29 0.23 36.83 0.97 100 27.91 0.28 35.37 0.78 

RXN 6 

Exon 20 ins 
GGT 

25 31.73 0.25 35.74 0.44 25 27.88 0.31 35.92 0.90 

Exon 20 ins 
CAC 

10 31.54 0.25 36.79 0.82 25 27.90 0.30 35.45 0.75 

RXN 7 
Exon 20 ins 

9  
75 31.26 0.18 37.14 0.36 75 28.25 0.10 37.38 0.33 

* The limit of detection (LOD) for EGFR exon 19 deletion variant c.2252_2276delinsA (p.T751_I759delinsN) is 75 copies 

per reaction under the specified assay conditions 
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ABI QuantStudioTM 5 (Software version 2.0): 

Reaction Mutation 

Minimum input (31.5 IC Ct) Maximum input (28 IC Ct) 

Mutant 
Copies 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 
Mutant 
Copies 

Average 
VIC Ct 

SD 
Average 
Target Ct 

SD 

RXN 1 

T790M (with 
Q787Q SNP) 

10 31.84 0.29 37.48 0.60 25 28.08 0.15 35.99 1.06 

T790M 25 31.84 0.24 35.77 0.89 25 28.09 0.18 34.97 0.70 

Exon 19 del 10* 31.52 0.15 36.70 0.80 10* 28.05 0.19 35.73 0.81 

L858R 25 31.49 0.41 35.72 1.12 25 28.23 0.37 35.24 0.99 

RXN 2 
C797S T>A 25 31.55 0.44 36.31 1.00 50 28.42 0.29 34.90 0.95 

C797S G>C 25 31.72 0.16 34.90 0.62 25 28.30 0.42 35.30 0.79 

RXN 3 L861Q 10 31.72 0.23 36.90 0.71 10 28.07 0.36 36.56 0.65 

RXN 4 S768I 75 31.96 0.33 37.29 0.73 75 28.22 0.39 36.87 0.65 

RXN 5 

G719A 25 32.75 1.75 34.55 0.75 100 28.01 0.31 34.38 1.57 

G719C 50 31.72 0.38 35.53 0.66 350 28.14 0.14 33.44 1.31 

G719D 50 31.75 0.34 36.25 0.83 300 28.10 0.27 35.40 1.11 

G719S 50 31.81 0.38 36.36 0.56 200 28.19 0.42 35.94 1.10 

RXN 6 

Exon 20 ins 
GGT 

25 31.56 0.59 34.88 0.85 25 28.40 0.40 35.36 0.60 

Exon 20 ins 
CAC 

25 31.88 0.20 35.69 0.59 25 28.31 0.30 35.13 0.52 

RXN 7 
Exon 20 ins 

9  
50 31.53 0.24 36.90 0.59 75 28.52 0.20 35.74 0.53 

* The limit of detection (LOD) for EGFR exon 19 deletion variant c.2252_2276delinsA (p.T751_I759delinsN) is 75 copies 

per reaction under the specified assay conditions 
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7.3 Accuracy 
Accuracy was assessed with cfDNA or cell-line standards with at least one representative mutation for each reaction, in 

duplicate. Samples were diluted to target approximately 2X LoD* at a total DNA input based on VIC Ct of ~30. This 

study was performed on Bio-Rad CFX96 (CFX Manager Software version 3.1). Results were reproducible on the ABI 

QuantStudioTM 5.  

 

  Reported Target Mutation (by reaction) 

  Rxn 1 Rxn 2 Rxn 3 Rxn 4 Rxn 5 Rxn 6 Rxn 7* Negative Total 

C
T

E
G

F
R

 

R
e
su

lt
s Positive 9 3 2 2 2 1 1  20 

Negative       1 1 2 

Total 9 3 2 2 2 1 2 1 22 
* Reaction 7 was tested below the assay’s LoD due to the mutation’s low allelic frequency in the tested samples. 

 

All mutations within the assay’s limit of detection were correctly called. 
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7.4 Cross-Reactivity  

Cross reactivity of each of the seven reactions was examined using synthetic mutant controls representing the 15 

target mutations, at 50% mutant allele frequency at the maximum input (VIC Ct of ~28), in duplicate. This study was 

performed on Bio-Rad CFX96 and ABI QuantStudioTM 5. Note: Blank cells show no cross reactivity. The assay’s target 

mutations are highlighted in green and produce an earlier signal than any off-target amplification. 

 

Bio-Rad CFX96 (CFX Manager Software version 3.1): 

  Average Target Ct for Each RXN 

  Mutation  1 2 3 4 5 6 7 

RXN 1 

T790M (with Q787Q SNP) 26.47 - - - - - - 

T790M 26.36 - - - - - - 

Exon 19del 26.34 - - - - - - 

L858R 26.93 - - - - - - 

RXN 2 
C797S T>A 39.08 26.76 - - - - - 

C797S G>C 39.05 26.63 - - - - - 

RXN 3 L861Q - - 26.46 - - - - 

RXN 4 S768I - - - 28.30 - - - 

RXN 5 

G719A - - - - 26.10 - - 

G719C - - - - 26.41 - - 

G719D - - - - 27.17 - - 

G719S - - - - 27.73 - - 

RXN 6 
Exon 20 ins GGT - - - - - 27.07 39.00 

Exon 20 ins CAC - - - - - 27.06 - 

RXN 7 Exon 20 ins 9 - - - - - - 30.55 

 

ABI QuantStudioTM 5 (Software version 2.0): 

  Average Target Ct for each RXN 

  Mutation  1 2 3 4 5 6 7 

RXN 1 

T790M (with Q787Q SNP) 26.35 - - - - - - 

T790M 26.01 - - - - - - 

Exon 19del 25.99 - - - - - - 

L858R 26.70 - - - - - - 

RXN 2 
C797S T>A 37.67 26.63 - - - - - 

C797S G>C 37.63 25.94 - - - - - 

RXN 3 L861Q 39.78 - 26.32 - - - - 

RXN 4 S768I 39.76 - - 29.07 - - - 

RXN 5 

G719A 39.72 - - - 25.92 - - 

G719C 39.81 - - - 26.77 - - 

G719D 39.83 - - - 26.96 - - 

G719S - - - - 28.00 - - 

RXN 6 
Exon 20 ins GGT 39.79 - - - - 26.82 39.95 

Exon 20 ins CAC - - - - - 26.93 - 

RXN 7 Exon 20 ins 9 - - - - - - 30.47 
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7.5 Limit of Blank 

Limit of Blank was evaluated using at least five unique WT cfDNA or fragmented gDNA samples as well as intact WT 

gDNA. Each sample was tested at four different inputs, ranging from half the minimum to twice the maximum assay’s 

input (i.e., VIC Ct of approximately 32.5, 31.5, 28 and 27). In addition, molecular grade water was also tested to 

demonstrate no non-specific background amplification. Each sample type was tested in at least 15 replicates across 

three reagent lots, at least 60 total replicates across the four inputs. No non-specific amplification was detected with 

WT samples or water. This study was performed on Bio-Rad CFX96 and ABI QuantStudioTM 5. 
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8. Appendix 

 

A. Mutations detected by this kit.  
Note: These notations were last updated in September 2020 based on COSMIC v92 

 
 

Nucleotide change Amino acid change Cosmic ID HGVS nt HGVS prot 

Exon 18   

c.2155G>A p.G719S 6252 LRG_304t1:c.2155G>A LRG_304p1:p.(Gly719Ser) 

c.2155G>T p.G719C 6253 LRG_304t1:c.2155G>T LRG_304p1:p.(Gly719Cys) 

c.2156G>A p.G719D 18425 LRG_304t1:c.2156G>A LRG_304p1:p.(Gly719Asp) 

c.2156G>C p.G719A 6239 LRG_304t1:c.2156G>C LRG_304p1:p.(Gly719Ala) 

Exon 19   

c.2233_2247del15 p.K745_E749delKELRE 26038 LRG_304t1:c.2233_2247del15 LRG_304p1:p.(Lys745_Glu749del) 

c.2234_2248del15 p.K745_A750delinsT 1190791 LRG_304t1:c.2234_2248del15 LRG_304p1:p.(Lys745_Ala750delinsThr) 

c.2235_2246del12 p.E746_E749delELRE 28517 LRG_304t1:c.2235_2246del12 LRG_304p1:p.(Glu746_Glu749del) 

c.2235_2248delinsAATTC p.E746_A750delinsIP 13550 LRG_304t1:c.2235_2248delinsAATTC LRG_304p1:p.(Glu746_Ala750delinsIlePro) 

c.2235_2249del15 p.E746_A750delELREA 6223 LRG_304t1:c.2235_2249del15 LRG_304p1:p.(Glu746_Ala750del) 

c.2235_2251delinsAATTC p.E746_T751delinsIP 13552 LRG_304t1:c.2235_2251delinsAATTC LRG_304p1:p.(Glu746_Thr751delinsIlePro) 

c.2235_2252delinsAAT p.E746_T751delinsI 13551 LRG_304t1:c.2235_2252delinsAAT LRG_304p1:p.(Glu746_Thr751delinsIle) 

c.2235_2255delinsAAT p.E746_S752delinsI 12385 LRG_304t1:c.2235_2255delinsAAT LRG_304p1:p.(Glu746_Ser752delinsIle) 

c.2236_2248delinsAGAC p.E746_A750delinsRP 12413 LRG_304t1:c.2236_2248delinsAGAC LRG_304p1:p.(Glu746_Ala750delinsArgPro) 

c.2236_2248delinsCAAC p.E746_A750delinsQP 13557 LRG_304t1:c.2236_2248delinsCAAC LRG_304p1:p.(Glu746_Ala750delinsGlnPro) 

c.2236_2250del15  p.E746_A750delELREA 6225 LRG_304t1:c.2236_2250del15 LRG_304p1:p.(Glu746_Ala750del) 

c.2236_2253del18 p.E746_T751delELREAT 12728 LRG_304t1:c.2236_2253del18 LRG_304p1:p.(Glu746_Thr751del) 

c.2236_2256del21 p.E746_S752delELREATS 133189 LRG_304t1:c.2236_2256del21 LRG_304p1:p.(Glu746_Ser752del) 

c.2237_2251delinsTTC p.E746_T751delinsVP 18421 LRG_304t1:c.2237_2251delinsTTC LRG_304p1:p.(Glu746_Thr751delinsValPro) 

c.2237_2251del15 p.E746_T751delinsA 12678 LRG_304t1:c.2237_2251del15 LRG_304p1:p.(Glu746_Thr751delinsAla) 

c.2237_2252delinsT p.E746_T751delinsV 12386 LRG_304t1:c.2237_2252delinsT LRG_304p1:p.(Glu746_Thr751delinsVal) 

c.2237_2253delinsTC p.E746_T751delinsV 133193 LRG_304t1:c.2237_2253delinsTC LRG_304p1:p.(Glu746_Thr751delinsVal) 

c.2237_2253delinsTTCCT p.E746_T751delinsVP 52935 LRG_304t1:c.2237_2253delinsTTCCT LRG_304p1:p.(Glu746_Thr751delinsValPro) 
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Nucleotide change Amino acid change Cosmic ID HGVS nt HGVS prot 

c.2237_2253delinsTTGCT p.E746_T751delinsVA 12416 LRG_304t1:c.2237_2253delinsTTGCT LRG_304p1:p.(Glu746_Thr751delinsValAla) 

c.2237_2254del18 p.E746_S752delinsA 12367 LRG_304t1:c.2237_2254del18 LRG_304p1:p.(Glu746_Ser752delinsAla) 

c.2237_2255delinsT p.E746_S752delinsV 12384 LRG_304t1:c.2237_2255delinsT LRG_304p1:p.(Glu746_Ser752delinsVal) 

c.2237_2256delinsTC p.E746_S752delinsV 18426 LRG_304t1:c.2237_2256delinsTC LRG_304p1:p.(Glu746_Ser752delinsVal) 

c.2237_2257delinsTCT p.E746_P753delinsVS 18427 LRG_304t1:c.2237_2257delinsTCT LRG_304p1:p.(Glu746_Pro753delinsValSer) 

c.2238_2248delinsGC p.L747_A750delinsP 12422 LRG_304t1:c.2238_2248delinsGC LRG_304p1:p.(Leu747_Ala750delinsPro) 

c.2238_2252delinsGCA p.L747_T751delinsQ 12419 LRG_304t1:c.2238_2252delinsGCA LRG_304p1:p.(Leu747_Thr751delinsGln) 

c.2238_2255del18 p.E746_S752delinsD 6220 LRG_304t1:c.2238_2255del18 LRG_304p1:p.(Glu746_Ser752delinsAsp) 

c.2239_2247delTTAAGAGAA p.L747_E749delLRE 6218 LRG_304t1:c.2239_2247delTTAAGAG
AA 

LRG_304p1:p.(Leu747_Glu749del) 

c.2239_2248TTAAGAGAAG>C p.L747_A750delinsP 12382 LRG_304t1:c.2239_2248delinsC LRG_304p1:p.(Leu747_Ala750delinsPro) 

c.2239_2251delinsC p.L747_T751delinsP 12383 LRG_304t1:c.2239_2251delinsC LRG_304p1:p.(Leu747_Thr751delinsPro) 

c.2239_2252delinsCA p.L747_T751delinsQ 12420 LRG_304t1:c.2239_2252delinsCA LRG_304p1:p.(Leu747_Thr751delinsGln) 

c.2239_2256delinsCAA p.L747_S752delinsQ 12403 LRG_304t1:c.2239_2256delinsCAA LRG_304p1:p.(Leu747_Ser752delinsGln) 

c.2239_2256del18 p.L747_S752delLREATS 6255 LRG_304t1:c.2239_2256del18 LRG_304p1:p.(Leu747_Ser752del) 

c.2239_2258delinsCA p.L747_P753delinsQ 12387 LRG_304t1:c.2239_2258delinsCA LRG_304p1:p.(Leu747_Pro753delinsGln) 

c.2239_2262del24 p.L747_K754delLREATSPK 24970 LRG_304t1:c.2239_2262del24 LRG_304p1:p.(Leu747_Lys754del) 

c.2240_2251del12 p.L747_T751delinsS 6210 LRG_304t1:c.2240_2251del12 LRG_304p1:p.(Leu747_Thr751delinsSer) 

c.2240_2254del15 p.L747_T751delLREAT 12369 LRG_304t1:c.2240_2254del15 LRG_304p1:p.(Leu747_Thr751del) 

c.2240_2257del18 p.L747_P753delinsS 12370 LRG_304t1:c.2240_2257del18 LRG_304p1:p.(Leu747_Pro753delinsSer) 

c.2248_2273delinsCC p.A750_E758delinsP 26440 LRG_304t1:c.2248_2273delinsCC LRG_304p1:p.(Ala750_Glu758delinsPro) 

c.2250_2264del15 p.T751_A755del 26718 LRG_304t1:c.2250_2264del15 LRG_304p1:p.(Thr751_Ala755del) 

c.2252_2275del24 p.T751_E758delTSPKANKE 23634 LRG_304t1:c.2252_2275del24 LRG_304p1:p.(Thr751_Glu758del) 

c.2252_2276delinsA p.T751_I759delinsN 96856 LRG_304t1:c.2252_2276delinsA LRG_304p1:p.(Thr751_Ile759delinsAsn) 

c.2252_2277delinsAT p.T751_I759delinsN 24270 LRG_304t1:c.2252_2277delinsAT LRG_304p1:p.(Thr751_Ile759delinsAsn) 
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Exon 20   

c.2369C>T p.T790M 6240 LRG_304t1:c.2369C>T LRG_304p1:p.(Thr790Met) 

c.2303G>T p.S768I 6241 LRG_304t1:c.2303G>T LRG_304p1:p.(Ser768Ile) 

c.2300_2308dup p.A767_V769dup 12376 LRG_304t1:c.2300_2308dupCCAGCG
TGG 

LRG_304p1:p.(Ala767_Val769dup) 

c.2310_2311insGGT p.D770_N771insG 12378 LRG_304t1:c.2310_2311insGGT LRG_304p1:p.(Asp770_Asn771insGly) 

c.2317_2319insCAC p.H773_V774insH 12377 LRG_304t1:c.2317_2319dupCAC LRG_304p1:p.(His773dup) 

c.2361G>A p.Q787Q 1451600 LRG_304t1:c.2361G>A LRG_304(p1):p.(=) 

c.2389T>A p.C797S 6493937 NM_005228.5:c.2389T>A NM_005228.5(NP_005219.2):p.(Cys797Ser) 

c.2390G>C p.C797S 5945664 NM_005228.5:c.2390G>C NM_005228.5(NP_005219.2):p.(Cys797Ser) 

Exon 21   

c.2573T>G p.L858R 6224 LRG_304t1:c.2573T>G LRG_304p1:p.(Leu858Arg) 

c.2582T>A p.L861Q 6213 LRG_304t1:c.2582T>A LRG_304p1:p.(Leu861Gln) 
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B. Troubleshooting 
 

Problem: Solution: 

Internal control (VIC) signal for a sample has a Ct value 

greater than the upper Ct cut-off specified in section 6. 

• If internal control signal appears after 
the cut-off or not at all, the reaction was 
under loaded (not enough DNA), rerun 
samples with more DNA.  

• If running a sample that is known to have 
PCR inhibitors (e.g., melanoma samples 
have melanin which is a PCR inhibitor), 
rerun sample with less DNA or dilute the 
sample in water 1:5 and re-run.  

• If increasing/decreasing DNA volume 
does not resolve the problem: 

1. Isolate fresh DNA (if possible). 
2. Ethanol precipitate and re-

suspend in a lower volume of 
solvent. 

3. Use a commercially available 
DNA concentrator. 

Target and/or internal control signals are negative for the 

positive control (PC). 

• Reagents may be degrading. Contact 
your supplier for more information.  

• To avoid future reagent failures, follow 
the storage and handling instructions in 
section 2.2 of the IFU. 

Abnormal spike in amplification plot of a sample using an 

ABI instrument. 

 

• The abnormal spike line may be a result 
of bubbles in the well containing the 
sample. Centrifuge the plate before 
rerunning the sample. 

• The abnormal spike may be an 
instrument collection error. Re-run 
another plate to make sure this is not 
reproducible. If the spike is reproducible 
contact the instrument manufacturer. 

Signal in NTC control. • Indicates setup or gDNA contamination. 
Evaluate lab procedure. Refer to section 
2.5 in the IFU for suggestions on 
minimizing bench contamination. 

• If target signal and/or internal control 
signal are present, the results may 
produce a false positive and a re-run is 
required.  

Target signal crosses the threshold for NTC samples when 

running assay on ABI instrument. 

 

• Ensure the manual thresholds suggested 
in the IFU are set. 

• Verify the signal is not true amplification 
by checking the signal in the 
multicomponent plot (ABI instruments). 
If the signal is horizontal, then this is not 
true amplification. 

• If signal in the multicomponent plot is 
linear and the signal crosses the 
threshold, adjust the baseline end cycle. 
Set the start cycle to: 3 and stop: 
earliest VIC Ct cycle (if signal still 
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crosses threshold, increase stop cycle 
number by increments of 3 until signal 
no longer crosses threshold). 

Wildtype sample has a target signal Ct value that falls 

within the parameters for a positive mutation status.  

• If the internal control signal is within 
range, then the wildtype sample has 
contamination from a positive sample, 
gDNA, or the positive control. Re-run the 
assay with a new wild type sample. 

•  It is also possible the wildtype sample is 
not a true wildtype. 
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10. Revision History 

To receive notifications regarding IFU changes, please register to the EntroGen technical support panel at 

entrogen.com/support/register. 

 

Last Change: April 2026 

Change Affected section(s) 

Updated LoD tables in section 7.2 to add a notation regarding exon 19 deletion 

variant c.2252_2276delinsA (p.T751_I759delinsN). 
7.2 

Updated table of listed exon 19 deletions to remove c.2253_2276del24 and 

c.2254_2277del24 variants. 
Appendix 
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11. Symbols Used 

 

The following symbols used on labels and packaging of this product conform to the harmonized standard EN980. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

 

Catalog Number 

 

Lot/Batch Number 

 

Expiration Date 

 

Storage Conditions 

 

Manufactured by 

 

Intended Use 

 

European Union Authorized Representative 
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12. Contact Information 

 

 

 

 
EntroGen, Inc 
20950 Warner Center Lane, Suite B 
Woodland Hills, CA 91367, USA 
Tel: +1 818 716 1070 
Email: support@entrogen.com 
Web: www.entrogen.com 

 

 
Tanja Topovšek s.p. 

Ul. Norberta Vebra 14 

2342 Ruše 

Slovenija 

Tel: +386 (0) 31 68 78 31  
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